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SUMMARY: 23 
This protocol describes a novel rAAV-based transient enhancer-reporter assay. This assay can be 24 
used to induce enhancer-driven expression in vivo in the mouse brain. 25 
 26 
ABSTRACT: 27 
Enhancers are binding platforms for a diverse array of transcription factors that drive specific 28 
expression patterns of tissue- and cell-type-specific genes. Multiple means of assessing non-29 
coding DNA and various chromatin states have proven useful in predicting the presence of 30 
enhancer sequences in the genome, but validating the activity of these sequences and finding 31 
the organs and developmental stages they are active in is labor-intensive process. Recent 32 
advances in adeno-associated virus (AAV) vectors have enabled the widespread delivery of 33 
transgenes to mouse tissues, enabling in vivo enhancer testing without necessitating a transgenic 34 
animal. This protocol shows how a reporter construct that expresses EGFP under the control of 35 
a minimal promoter, which does not drive significant expression on its own, can be used to study 36 
the activity patterns of candidate enhancer sequences in the mouse brain. An AAV-packaged 37 
reporter construct is delivered to the mouse brain and incubated for 1–4 weeks, after which the 38 
animal is sacrificed, and brain sections are observed under a microscope. EGFP appears in cells 39 
in which the tested enhancer is sufficient to initiate gene expression, pinpointing the location 40 
and developmental stage the enhancer is active in the brain. Standard cloning methods, low-cost 41 
AAV packaging, and expanding AAV serotypes and methods for in vivo delivery and standard 42 
imaging readout make this an accessible approach for the study of how gene expression is 43 
regulated in the brain. 44 
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 45 
INTRODUCTION:  46 
Enhancers are genomic cis-regulatory elements that serve as transcription factor binding sites 47 
and can drive the expression of a target gene in a spatiotemporally specific manner1,2. They are 48 
differentially active in different cell types, tissues, and stages of development and can be 49 
substrates of disease risk-related genomic variation3,4. Thus, the need to understand the 50 
dynamics of enhancer function is critical to progress in both translational and basic science 51 
applications within genomics. In silico predictions of enhancer activity can serve as excellent 52 
resources for generating hypotheses as to enhancer capability5,6. Such predicted enhancer 53 
activity can require additional validation and interrogation for a full understanding of the 54 
functional activity. Enhancer reporter assays have proved valuable for this purpose across a 55 
variety of systems, from cells to animals7–9. Towards extending these studies in a flexible and 56 
cost-effective transient in vivo context, this protocol describes the use of in vivo AAV-based 57 
methods to test putative enhancer sequences for their ability to drive the expression of an 58 
ectopic reporter gene in the postnatal mouse brain. This family of methods has utility for 59 
interrogating single candidate sequences or parallel library screening and is relevant for basic and 60 
translational research. 61 
 62 
This method combines in a single plasmid a putative enhancer candidate DNA sequence with a 63 
reporter gene (here EGFP), under the control of a minimal promoter that alone does not drive 64 
significant expression. The plasmid is packaged into recombinant AAV (rAAV) and injected into 65 
an animal model.  While the application here is to the brain, various rAAV serotypes enable 66 
infection across different tissue types so that this approach can be extended to other systems10. 67 
After a period of time, the brain can be collected and assayed for the expression of the reporter 68 
gene. Strong expression, compared with controls, indicates that the tested candidate sequence 69 
was able to “enhance” the expression of the gene (Figure 1). This simple design offers an easy 70 
and clear approach to test a sequence for enhancer activity in vivo in the brain.  71 
 72 
In addition to testing for enhancer capability of a sequence, this method can be combined with 73 
techniques to determine cell-type enhancer activity. In sequence-based approaches to 74 
determining differential enhancer activity, sorting cells on cell-type-specific markers prior to DNA 75 
and RNA sequencing can allow researchers to determine if different cell types show differential 76 
enhancer activity, as was described in Gisselbrecht et al.11. In imaging-based approaches, co-77 
labeling images with cell-type-specific markers allow examining whether cells exhibiting 78 
enhancer-driven fluorescence also display cell-type markers of interest12–16. Enhancer reporter 79 
assays enable direct testing of risk-associated allelic variation in enhancers for effects on 80 
enhancer capability. The vast majority of risk loci identified in genome-wide association studies 81 
(GWAS) lie in non-coding regions of the genome17. Functional annotation studies of these risk 82 
loci indicate that a large portion likely act as enhancers18–20.  MPRA deployment in vivo can allow 83 
testing of these risk-associated variants for enhancer activity in brain12,21. Finally, delivery and 84 
collection at different time points can offer insights into the developmental stages during which 85 
an enhancer is active. 86 
 87 
Enhancer-reporter plasmid designs are diverse and can be customized to suit experimental goals. 88 



   

 

There are several options for minimal promoters that have been used in enhancer research, such 89 
as the human β-globin minimal promoter22 and the mouse Hsp68 minimal promoter23. These 90 
promoters are known to drive low levels of expression unless coupled with an enhancer element 91 
to activate them. In contrast, constitutive promoter elements drive strong expression of the 92 
transgene, useful for positive control or to test for enhancer function against a background of 93 
robust expression. Common choices for constitutive promoters include CAG, a hybrid promoter 94 
derived from chicken β-actin and cytomegalovirus immediate-early enhancer24, or human 95 
EF1α25. Since enhancers are known to work bidirectionally26, the orientation and location of the 96 
enhancer relative to the minimal promoter are flexible (Figure 2A). Traditional enhancer-reporter 97 
assays place the enhancer upstream of the promoter and, in library deliveries, include a barcode 98 
sequence downstream of the reporter gene to associate sequencing reads with the tested 99 
enhancer27. However, enhancers can also be placed in the open reading frame of the reporter 100 
gene and serve as their own barcode sequence, as is done in STARR-seq28. The protocol described 101 
here utilizes the STARR-seq assay design, placing the candidate enhancer sequence into the 3’ 102 
UTR of the reporter gene. While the STARR-seq orientation offers the benefit of more 103 
streamlined cloning, it is less well understood than the conventional approach and may induce 104 
variable RNA stability between constructs. The described methods can be easily adapted to either 105 
the STARR-seq or conventional orientation with minor alterations to the cloning process that 106 
have been described elsewhere27,29. 107 
 108 
Different methods of AAV delivery can be employed to further customize this technique to fit 109 
experimental goals (Figure 2B). Direct intracranial injections, described further in this protocol, 110 
deliver a high concentration of virus directly to the brain30. This gives a high transduction 111 
efficiency centered at the site of injection, making this an excellent technique for experiments 112 
looking to maximize the density of transduced cells over an area of tissue. Stereotactic injection 113 
can help standardize the site of injection across animals for reproducible localized transduction. 114 
Intracranial injections are most straightforward in early postnatal animals. As an alternative 115 
technique, systemic injections can deliver transgenes using AAVs with serotypes capable of 116 
crossing the blood-brain barrier31. Tail-vein injections allow the virus to circulate throughout the 117 
body, enabling generalized delivery across many tissues10. Retro-orbital injections are another 118 
systemic injection technique that delivers the virus behind the eye into the retro-orbital sinus32. 119 
This offers a more direct route for the AAV from the venous system to the brain, resulting in a 120 
higher concentration of transduced cells in the brain than injections into more peripheral blood 121 
vessels33.  122 
 123 
Another flexible aspect of this technique is the method of readout. Broadly, options can be 124 
described as reporter-based or sequencing-based (Figure 2C). Incorporating a fluorescent 125 
reporter such as GFP into the open reading frame of the construct results in the expression of 126 
the fluorescent protein in any transduced cells where the candidate enhancer drove expression. 127 
Labeling and imaging techniques such as immunohistochemistry enable signal amplification. 128 
Sequencing-based readout techniques involve identifying sequences from the delivered 129 
construct in RNA collected from the tissue. By quantifying the amount of viral DNA that was 130 
initially delivered, the comparison of expressed RNA versus delivered DNA can be used to 131 
determine the degree to which a tested enhancer sequence was capable of driving increased 132 



   

 

expression of the transgene, for example, in the context of a massively parallel reporter assay 133 
(MPRA). MPRAs offer a powerful expansion of these techniques to test up to thousands of 134 
candidate enhancers for activity simultaneously and have been described extensively in 135 
genomics research12,27,34–36. Higher throughput screening is achieved by executing cloning, 136 
packaging, delivery, and sequencing steps for candidate enhancers in batch rather than 137 
individually.  138 
 139 
Candidate enhancer selection provides another opportunity for flexibility (Figure 2D). For 140 
example, this assay can be used to identify enhancers of a specific gene, to ascertain the function 141 
of non-coding DNA regions of interest, or to determine specific cell types or developmental 142 
stages during which an enhancer is active - all of which serve goals both in basic science and in 143 
disease research. Generally, candidate enhancer selection is driven by in silico predictions of 144 
enhancer activity. Commonly, in silico predictions include ChIP-seq for histone modifications that 145 
indicate likely enhancers, such as H3K27ac37 and chromatin accessibility mapping38. Finally, a 146 
growing area of research is the function-based screening of synthetically designed enhancer 147 
elements, enabling studies of how enhancer sequence directs function39 and the design of 148 
enhancers with specific properties40.  149 
 150 
PROTOCOL: 151 
 152 
This protocol has been approved by the UC Davis Institutional Animal Care and Use Committee 153 
(Protocol #22339) and the UC Davis Institutional Biosafety Committee (BUA-R1903). This protocol 154 
has been tested on C57BL/6J mice of both sexes at postnatal day 0–1. 155 
 156 
1. Clone the enhancer candidate sequence into the AAV vector plasmid.  157 
 158 
NOTE: The representative protocols are given, but the cloning strategy has a high degree of 159 
flexibility. 160 
 161 
1.1. Select or design a reporter construct. Here, the enhancer candidate is inserted into the 3’ 162 
untranslated region (UTR) of the EGFP reporter gene, which is expressed under the control of the 163 
Hsp68 minimal promoter. 164 
 165 
NOTE: Many MPRA plasmid constructs appropriate for this assay have been deposited to 166 
Addgene41 and are available for research use.  167 
 168 
1.2. Design PCR primers to amplify a sequence of interest. Add to the 5’ end of the primers 169 
the appropriate homology arm for Gibson cloning (~35 bp corresponding to sequence 5’ 170 
upstream of the insertion location, top strand for the forward primer, and bottom strand for the 171 
reverse primer).  172 
 173 
NOTE: Ensure that the base primer sequence is ~18–24 bp long and ~50%–60% GC content with 174 
a melting temperature of approximately 57–59 °C. 175 
 176 



   

 

1.3. Perform PCR from a DNA sample using the designed primers. 177 
 178 
1.3.1. Assemble the PCR reaction mix in 0.2 mL PCR tubes as described in Table 1. 179 
 180 
1.3.2. Place the PCR reaction mix(es) on a thermal cycler and cycle according to the program 181 
mentioned in Table 1. 182 
 183 
1.3.3. Confirm the success of PCR by running 5 µL of PCR product on a 0.7%–1% agarose gel at 184 
100 V for 30–60 min. Check for the fragment of predicted length. 185 
 186 
1.3.4. Cleanup the PCR product using a commercial enzymatic reaction cleanup column kit. The 187 
final eluate is the cloning insert. 188 
 189 
1.4. Perform restriction digestion to linearize the AAV vector at the unique cloning site to 190 
insert the enhancer into the vector.  191 
 192 
1.4.1. The cloning site in the 3’ UTR of the enhancer reporter construct used here is bounded by 193 
unique PacI and AscI restriction sites. Perform a digest to linearize the plasmid at this location 194 
according to the following parameters ( steps 1.4.2–1.4.4). 195 
 196 
1.4.2. Digest 1–10 µg of vector DNA using PacI and AscI, depending on how many cloning 197 
reactions will be needed. Prepare the reactions using the supplied buffer according to the 198 
manufacturer’s instructions. 199 
 200 
1.4.3. Incubate at 37 °C for 1–2 h to digest the vector DNA. (If digesting more than 5 µg in a 50 201 
µL reaction, longer incubation may be necessary.) 202 
 203 
1.4.4. After 1–2 h of incubation, inactivate the enzyme by incubating at 65 °C for 20 min. 204 
 205 
1.4.5. Separate the restriction digest fragments by gel electrophoresis using a 0.7%–1% agarose 206 
gel, run at 100 V for 30–60 min. 207 
 208 
1.4.6. Excise the band for the linearized vector and purify using a commercial gel extraction kit. 209 
 210 
1.5. Perform Gibson cloning reactions and transform 211 
 212 
1.5.1. Determine the concentration of the purified vector and the cloning insert using a 213 
spectrophotometer.  214 
 215 
NOTE: DNA absorbs light at 260 nm, while contaminants absorb light at 230 nm and 280 nm. High 216 
ratios (>1.8) of 260/230 and 260/280 indicate highly purified DNA.  217 
 218 
1.5.2.  Assemble Gibson cloning reactions in 0.2 mL PCR tubes: 5 µL of 2x Gibson master mix, 219 
0.02–0.5 pmol DNA fragments in a ratio of 3:1 insert to vector (Optimal DNA concentration for 220 



   

 

the reaction should be determined empirically) and Nuclease-free water (bring up the volume to 221 
10 µL). 222 
 223 
1.5.3. Incubate Gibson reactions at 50 °C for 20 min in a thermal cycler. 224 
 225 
1.6. Transform recombination deficient (recA-) competent Escherichia coli (E. coli). 226 
 227 
1.6.1. Set a water bath to 42 °C and thaw the commercially available competent cells on ice. 228 
 229 
NOTE: This step can be done prior to step 1.4, and the cells can thaw while preparing and 230 
incubating the Gibson reaction. 231 
 232 
1.6.2. Aliquot 30–50 µL of cells into 2.0 mL microcentrifuge tubes. Add 2 µL of Gibson reaction 233 
to an aliquot and label the tube with the identity of the Gibson. Incubate the cells on ice for 30 234 
min. 235 
 236 
NOTE: Use 5–10 ng of undigested empty vector as a positive control and water as a negative 237 
control. 238 
 239 
1.6.3. Heat-shock the cells in the 42 °C water bath for 30–45 s, immediately return the tubes to 240 
ice, and let them recover for 5 min. 241 
 242 
1.6.4. While on ice, add 400–950 µL of the commercially available recovery media. 243 

 244 
NOTE: The recovery media used in these experiments contains 2% vegetable peptone, 0.5% yeast 245 
extract, 10 mM NaCl, 2.5 mM KCl, 10 mM MgCl2, 10 mM MgSO4, and 20 mM glucose. 246 
 247 
1.6.5. After recovery on ice, fully recover the cells by incubating at 37 °C with gentle agitation 248 
of 250 RPM for 30–60 min. 249 
 250 
1.6.6. Pellet the cells by centrifugation at 5,000 x g for 5 min and remove 400 µL of the 251 
supernatant, leaving ~50 µL of bacteria to plate. 252 
 253 
1.6.7. Plate on selective media and incubate at 37 °C overnight. 254 

 255 
NOTE: The selective media use in these experiments contains 1.0% tryptone, 0.5% yeast extract, 256 
1.0% sodium chloride, 1-2% agar, 96-97% water, and carbenicillin at a concentration of 100 257 
µg/mL. Always use recombination deficient strains of bacteria for cloning viral plasmids because 258 
the viral inverted terminal repeats (ITRs) have matching sequences and can undergo homologous 259 
recombination. However, recA- strains of bacteria still undergo low levels of recombination. The 260 
reporter plasmid used here is a self-complementary AAV, where the sequence of one of the ITRs 261 
has been altered and no longer perfectly matches the other ITR. Growing the bacteria at 30 °C is 262 
also recommended for further slowing the rate of homologous recombination.  263 
 264 



   

 

1.7. Verify clones and recover plasmids. 265 
 266 
1.7.1. Prepare a PCR master mix using forward and reverse primers (Table of Materials)  that 267 
anneal to the vector, flanking the insert location. Aliquot 10 µL volumes into 0.2 mL PCR strip 268 
tubes. 269 
 270 
1.7.2. In 14 mL round-bottom tubes, prepare 5 mL aliquots of antibiotic selective LB broth, one 271 
for each colony being tested via PCR and negative control. 272 
 273 
1.7.3. Use a sterile toothpick or pipette tip to pick an individual colony and roughly scrape the 274 
colony down into the bottom of one PCR tube.  275 

 276 
1.7.4. When the colony has dissociated into the PCR master mix, drop the toothpick or tip into 277 
one of the LB aliquots and label the 14 mL tube with the Gibson reaction and the PCR tube 278 
number. 279 
 280 
1.7.5. Place the colony PCR reactions on a thermal cycler and cycle with the program described 281 
in Table 2. 282 
 283 
1.7.6. Incubate the 5 mL liquid cultures inoculated with toothpicks or pipette tips in a shaking 284 
incubator set to 37 °C and 180 RPM. 285 
 286 
1.7.7. Run the colony PCR reactions on a 0.7%–1% agarose gel at 100 V for 30–60 min and 287 
visualize the bands in a gel doc imaging system.  288 
 289 
1.7.8. Discard the 5 mL cultures that do not display the predicted PCR band. 290 
 291 
1.7.9. For each successfully integrated clone, allow the 5 mL cultures to grow overnight and then 292 
perform a plasmid mini prep from 4.5 mL using a commercial kit. Reserve 0.5 mL of the liquid 293 
culture and save at -80 °C as a glycerol stock. 294 
 295 
1.7.10. Confirm that the transgenes contained within the plasmids are free of undesirable 296 
mutations using Sanger sequencing42. 297 
 298 
1.7.11. After the reporter construct has been confirmed to be successfully cloned, use the saved 299 
glycerol stock to inoculate a 5 mL starter culture and grow for 8–16 h in a shaking incubator at 300 
30 °C and 180 RPM. 301 
 302 
1.7.12. Once the broth is cloudy, dilute the starter culture 1,000x in 250–300 mL of fresh selective 303 
LB broth and incubate at least overnight in a shaking incubator at 30 °C and 180 RPM. Then purify 304 
the plasmid using a commercial plasmid maxi kit. 305 
 306 
NOTE: Bacteria will grow more slowly at 30 °C compared to 37 °C, but this is the best temperature 307 
for slowing the rate of spontaneous recombination when growing large cultures. 308 



   

 

 309 
1.7.13. Perform an XmaI digest to test for recombination of the ITRs using steps 1.4.2–1.4.5, 310 
substituting XmaI instead of PacI and AscI. Visualize the bands on a gel doc imaging system.  311 
 312 
NOTE: An rAAV plasmid with both ITRs present will yield two bands on a gel following this digest: 313 
one the length of the rAAV genome and the other the length of the rest of the plasmid backbone. 314 
If there is only one band, then the ITRs have undergone homologous recombination, and the 315 
rAAV plasmid will not be capable of packaging viral particles. The rAAV plasmid backbone 316 
described here has been designed so that only XmaI sites occur in the ITRs. If the enhancer 317 
candidate insert also contains any XmaI sites, update the predicted band results and analysis 318 
accordingly. 319 
 320 
2. Obtain packaged rAAV. 321 
 322 
2.1. Use packaged rAAV (professionally or in-house) for the experiments in this study.  323 

 324 
NOTE: There are many options for packaging an rAAV. An rAAV can be professionally packaged 325 
at a company or a university core facility. The rAAV can also be packaged in-house using different 326 
techniques that range in complexity and need for specialized equipment43,44. The primary 327 
concern is obtaining a vector that is high quality and that the infectious titer has been determined 328 
to a high degree of certainty. Both professionally packaged and in-house packaged rAAVs were 329 
used for different experiments described in this study. 330 
 331 
3. Intracranially inject rAAV-packaged plasmid into neonatal mice.  332 
 333 
3.1. Prepare rAAV mixture for delivery. 334 
 335 
3.1.1. If the intent is to compare the expression patterns between different enhancer reporter 336 
viruses, equalize the titers of all viruses to be compared by diluting all to match the least 337 
concentrated virus. 338 
 339 
3.1.2. Mix together a 2:1 or 3:1 ratio of enhancer reporter virus and constitutively expressed 340 
control reporter virus and add a small amount (0.06% final concentration) of Fast Green dye.  341 
 342 
NOTE: Fast Green is a dye that is used widely in injections of experimental animals, including with 343 
AAV, to visualize the injection site during and immediately after the procedure45–48. While this is 344 
an important quality assurance step, it is possible that the addition of dye could interfere with 345 
transduction. Reconsidering the use of injection dye may be important for protocol optimization 346 
in certain cases. The constitutively driven control virus is absolutely critical for comparing 347 
independent injections. Virus injections will vary in location and extent of transduction from 348 
animal to animal. The constitutive control will enable excluding failed injections from analysis 349 
and provide a standard for normalization of variation in virus delivery. 350 
 351 
3.1.3. Break the tip of a pulled glass pipette made from a µL-graduated capillary tube by using 352 



   

 

it to gently pierce a delicate lint-free wipe. Then insert the pulled glass pipette into the aspirator 353 
assembly consisting of a device for applying pressure connected to 15-inch long rubber tubing 354 
ending with a rubber gasket for holding a micro-capillary pipette. 355 
 356 
NOTE: The “device for applying pressure” may be a syringe or a mouthpiece. If a syringe is to be 357 
used, a second person will be required to apply pressure through the syringe while the 358 
experimenter manipulates the pipette in one hand and the animal in the other. If using a 359 
mouthpiece, enabling the experimenter fine control over both the positions of the animal and 360 
pipette and the pressure applied to the syringe, extra care to avoid virus contamination is 361 
required. 362 
 363 
3.1.4. Apply negative pressure through the aspirator assembly to draw a small volume (~0.2–364 
0.5 µL) of mineral oil into the glass pipette.  365 
 366 
NOTE: This step is very important to provide a barrier to prevent aerosolized viral particles from 367 
contaminating the aspirator assembly. 368 
 369 
3.1.5. Set the prepared aspirator assembly aside and keep the virus on ice until ready to inject. 370 
 371 
3.2. Cryo-anesthetize the neonatal mice in a dry plastic dish partially submerged in ice until 372 
the cessation of the pedal withdrawal reflex (~5 min). 373 
 374 
3.3. Use negative pressure through the aspirator assembly to draw the virus mixture into the 375 
pulled glass pipette until the meniscus passes the 2 µL tick mark. 376 
 377 
3.4. Remove the mouse from the cold chamber and position it on the benchtop. Locate the 378 
bilateral injection sites midway between lambda and bregma and midway between the sagittal 379 
suture and each eye. Sanitize both areas with an alcohol wipe. 380 
 381 
3.5. Use the pulled glass pipette to pierce the skull of the neonatal mice and gently apply 382 
positive pressure through the aspirator assembly as the needle enters the brain. Watch the 383 
meniscus of the virus mixture. Resistance to the pressure applied will decrease when the tip of 384 
the pipette reaches the lateral ventricle. Dispense 1 µL of the virus, withdraw the pipette, and 385 
repeat for the other lateral ventricle. 386 
 387 
3.6. Place the mouse on a heating pad or a warming chamber to recover. Once awake and 388 
active, return the animal to its home cage. 389 
 390 
4. Collect tissue and perform immunohistochemistry. 391 
 392 
4.1. After sufficient time following virus transduction, anesthetize the mice and sacrifice by 393 
transcardial perfusion. 394 
 395 
NOTE: Many experiments, including the representative results shown here, allow a period of 4 396 



   

 

weeks or longer for the virus to transduce. However, self-complementary AAVs can show strong 397 
expression as early as 7 days12. The desired incubation period may need to be optimized 398 
depending on specific experimental techniques and goals. 399 
 400 
4.1.1. Prepare a peristaltic pump with intravenous infusion tubing and a 25 G needle. 401 
 402 
4.1.2. Prepare 1x PBS and 4% paraformaldehyde (PFA) and place them on ice. 403 
 404 
4.1.3. Place the intake end of the tubing in the ice-cold 1x PBS. Set the flow rate (2.5 mL/min for 405 
P7 mice, 3.5 mL/min for P28 mice) and run the pump until the buffer is drawn all the way through 406 
the tubing and is cleared of bubbles. Set the needle aside until ready for perfusion. 407 
 408 
4.1.4. Place the previously injected mouse in a drop jar chamber with a small volume of 409 
isoflurane and seal the chamber to anesthetize the mouse. Wait for ~5 min and then open the 410 
chamber and check for a pedal withdrawal reflex. Proceed once the animal is unconscious. 411 
 412 
NOTE: Throughout the perfusion, it is important to keep extra isoflurane on hand in case the 413 
mouse starts to regain consciousness. If this occurs, a small amount of isoflurane may be 414 
deposited on a delicate lint-free wipe and placed over the mouse’s face for a few seconds until 415 
the animal is again fully unconscious. 416 
 417 
4.1.5. Use surgical scissors to open the abdomen and chest of the mouse, remove the rib cage 418 
and expose the heart.  419 
 420 
4.1.6. Use a pair of iris micro scissors to make a small incision in the mouse’s right atrium, insert 421 
the IV needle into the left ventricle, and activate the peristaltic pump. 422 
 423 
4.1.7. Perfuse the animal with ice-cold 1x PBS until the blood flushing out of the incision in the 424 
right atrium runs clear. Clearing the tissue of blood is very important because red blood cells have 425 
autofluorescence, and blood vessels may impair the ability to image reporter-expressing cells. 426 
 427 
4.1.8. Pause the peristaltic pump and move the intake tubing from the PBS to the 4% PFA. 428 
Reactivate the pump and perfuse 1 mL/g of body weight, ~25 mL for an adult mouse.  429 

 430 
NOTE: Fixation tremors should be observable, and the body of the mouse should stiffen. 431 
 432 
4.2. Dissect and post-fix the brain. 433 
 434 
4.2.1. Remove the mouse’s head with surgical scissors. 435 
 436 
4.2.2. Using small surgical scissors, start at the base of the skull and make an incision along the 437 
midline of the head and pull back the skin and underlying tissue to expose the skull. 438 
 439 
4.2.3. Using iris scissors, carefully cut the back of the skull, starting at the foramen magnum and 440 



   

 

continuing up toward and along the sagittal suture until the olfactory bulbs are passed. 441 
 442 
4.2.4. Insert the scissors into the skull over the olfactory bulbs and make two horizontal cuts in 443 
the skull. Make a similar pair of horizontal cuts in the occipital bone. The horizontal and midline 444 
cuts create a pair of door-like flaps in the top of the skull.  445 

 446 
4.2.5. Peel back the flaps of the skull to fully expose the brain. Use a pair of tweezers to sever 447 
the olfactory bulbs from the skull and to cut the cranial nerves, freeing the brain from the skull. 448 
 449 
4.2.6. Drop the brain into a 15 mL conical tube with 3–5 mL of 4% PFA in PBS. Post-fix 6 h to 450 
overnight. Do not over-fix the tissue.  451 
 452 
4.3. Prepare the brains for cryosectioning. 453 
 454 
4.3.1. Transfer the fixed brain to a new 15 mL conical tube with 12–14 mL of 30% sucrose in PBS 455 
for dehydration. Incubate at 4 °C until the brain sinks to the bottom of the tube (2–3 days). 456 
 457 
4.3.2. Submerge the fixed and dehydrated brain in optimum cutting temperature (OCT) 458 
compound in a 15 mm x 15 mm x 5 mm cryomold. Add OCT until the brain is fully covered. 459 
 460 
4.3.3. Place cryomold on a block of dry ice and freeze the sample in a solid block of OCT (~ 5 461 
min). 462 
 463 
NOTE: OCT blocks can be stored at -80 °C for months to years. 464 
 465 
4.3.4. Label the cryomold with the sample name and the orientation of the brain. 466 
 467 
4.4. Obtain coronal sections using a cryostat microtome. 468 
 469 
4.4.1. Mark the orientation of the brain on the OCT block in pencil and remove the block from 470 
the cryomold inside the cryostat. 471 
 472 
4.4.2. Position the OCT block so that the brain is oriented with the olfactory bulbs facing the 473 
blade of the cryostat and adhere the block to the object holder of the cryostat with some fresh 474 
OCT. 475 
 476 
4.4.3. Once frozen in place, begin cutting 50 µm sections through the block following steps 477 
4.4.4–4.4.6. 478 
 479 
4.4.4. Do not use the anti-roll plate. Sections will curl into tight rolls as they are cut and will 480 
collect either on top of the block or fall below into a collection tray.  481 
 482 
4.4.5. Watch the shape of the block in the first few cuts that are made. Make vertical cuts 483 
through the block, producing an even face when beginning to cut. Adjust the angle using the 484 



   

 

sample adjustment arms if needed. 485 
 486 
4.4.6. When the olfactory bulbs are visible, pay close attention to the shape of the sections. If 487 
one appears larger than the other, the cuts are at an angle relative to the brain, and it is necessary 488 
to straighten the orientation of the brain against the blade using the sample adjustment arms. 489 
 490 
NOTE: If cutting straight, the cortex should begin to appear above each olfactory bulb at the same 491 
time. 492 
 493 
4.4.7. Once the olfactory bulb has been sectioned and rostral brain tissue is visible, reduce the 494 
cutting thickness to 30–35 µm and begin to collect the floating sections. Follow steps 4.4.8–4.4.13 495 
for sectioning the brain. 496 
 497 
4.4.8. Brush all previous sections off of the block and object holder so that they fall into the 498 
collecting tray. Brush them off to one side of the tray and keep them separate. If the pile is too 499 
big, then empty the tray. 500 
 501 
4.4.9. Dispense 1 mL of PBS into each well of a 24 well plate. Label 1 row for each brain. 502 
 503 
4.4.10. Cut 6 coronal sections. Retrieve the sections using cold tweezers and arrange them on the 504 
cryostat stage. Repeat this step 2 or 3 times, keeping the groups of 6 sections separate. 505 
 506 
4.4.11. Wet a size 000 paintbrush with PBS and dab away excess liquid on a lint-free tissue or 507 
paper towel. Use the paintbrush to gently pick up each section, one at a time, and place it in the 508 
appropriate wells of the 24 well plate. 509 
 510 
4.4.12. Place one of the 6 sections from the group of slices into each of the 6 wells in a row of the 511 
24 well plate. This ensures that each well contains representative sections that span the 512 
sectioned area of the brain. 513 
 514 
4.4.13. Continue sectioning in groups of 6 until the caudal end of the cerebral cortex has been 515 
sectioned. 516 
 517 
4.4.14. For storage, seal the 24 well plate with parafilm and store at 4 °C. 518 
 519 
NOTE: Sections are stable for 1-2 months at 4 °C. A PBS solution with 0.1% Sodium azide may be 520 
used to inhibit bacterial growth and prolong the shelf life of the sections. However, if the sections 521 
are to be stored for longer than 2 months, they should be placed in cryoprotectant solution and 522 
frozen at -20 °C for best results. 523 
 524 
4.5. Perform immunohistochemistry for reporter gene signal amplification. 525 
 526 
NOTE: All steps except antigen retrieval should be performed using gentle-to-moderate agitation 527 
(~100 RPM) on an orbital shaker.To preserve native fluorescence of the control reporter 528 



   

 

(mRuby3), all steps should be protected from light as much as possible. 529 
 530 
4.5.1. Prepare necessary buffers as described in Table 3. 531 
 532 
4.5.2. Prepare a new 24 well plate with one row for each brain being stained. In the first column 533 
of wells, add 1 mL of PBS to each well. 534 
 535 
4.5.3. Using a size 000 paintbrush, gently transfer 1 well of sections from the original collection 536 
well to the fresh PBS in the new 24 well plate for a quick rinse to remove residual OCT compound. 537 
 538 
4.5.4. Add 1 mL of ARB to the next well in the 24 well plate and transfer sections to this well. 539 
Incubate in an oven at 60 °C for 1 h. 540 
 541 
4.5.5. Allow the plate to cool at room temperature (RT) for 20 min. 542 
 543 
4.5.6. Add 1 mL of PB to the next well and transfer the sections to this well. Incubate at RT for 544 
20 min. 545 
 546 
4.5.7. Add 500 µL of BB to the next well and transfer the sections to this well. Incubate at RT for 547 
1 h. 548 
 549 
4.5.8. Add 2 mL of WB to the BB and then pipette out ~2 mL of solution and discard, leaving a 550 
diluted BB solution in the well. Repeat until the sections are clearly visible. 551 
 552 
4.5.9. Dilute the primary antibody (Chicken IgY anti-GFP, 1:1000) in BB. Add 350–500 µL of 553 
primary antibody solution to the next well and transfer the sections to this well. Seal the plate 554 
with parafilm and incubate at 4 °C overnight. 555 
 556 
4.5.10. Dilute BB with WB as done previously until the sections are clearly visible. 557 
 558 
4.5.11. Add 1 mL of WB to the next well and transfer the sections to this well. Incubate at RT for 559 
20 min. 560 
 561 
4.5.12. Remove ~800–900 µL of buffer and discard. Add 1 mL fresh WB and incubate 20 min. 562 
Replace 1 mL of wash buffer 4 more times for a total of 5, 20 min washes.  563 
 564 
4.5.13. Dilute the secondary antibody (Donkey anti-chicken Alexa Fluor 488 conjugated, 1:500) 565 
in BB. Add 350–500 µL of the secondary antibody solution to a new well. Incubate at RT for 45 566 
min to 1 h. 567 
 568 
NOTE: This is the seventh well, so if staining sections from more than 2 brains, a new plate will 569 
be needed at this point. 570 
 571 
4.5.14. Dilute BB with WB as previously and transfer the sections to a new well filled with 1 mL 572 



   

 

of WB. Wash the sections as done previously for 20 min 3 times. 573 
 574 
4.5.15. Prepare a working solution of DAPI in PBS (final concentration 0.04–0.8 µg/mL). Protect 575 
solution from light. 576 
 577 
4.5.16. Add 1 mL DAPI solution to the next well and transfer the sections to this well. Incubate at 578 
RT for ~5 min. 579 
 580 
4.5.17. Transfer the sections back to WB and gently mount on microscope slides using a size 000 581 
paintbrush. Allow the slides to air dry. 582 
 583 
4.5.18. Apply coverslips with an appropriate mounting media. Allow slides to cure at RT in the 584 
dark overnight. 585 
 586 
5. Image and analyze brain tissue sections for enhancer activity. 587 
 588 
5.1. Use a low magnification (5x) objective lens to record fluorescence images that span the 589 
brain section. 590 
 591 
5.2. Locate the injection site and evaluate the extent of the virus transduction based on the 592 
density and intensity of red fluorescent cells. Take care to compare animals that were transduced 593 
similarly. 594 
 595 
5.3. Record detailed fluorescent images with a higher magnification objective lens (≥25x) if 596 
desired. 597 
 598 
NOTE: Always be sure to use the same settings for acquisition parameters such as excitation light 599 
intensity, filters, and exposure time between samples that are to be compared. 600 
 601 
5.4. Process the images using image analysis software. 602 
 603 
NOTE: Processing may be done in any image analysis software package. The following steps are 604 
suggestions for determining whether a sequence acts as an enhancer in the reporter construct 605 
context (a yes or no question) using the open-source FIJI distribution of ImageJ. More in-depth 606 
photometry may be appropriate when comparing degrees of activity between enhancer variants. 607 
Images from different samples should always be processed consistently in order to be compared. 608 
 609 
5.4.1. Apply filters to reduce noise. In Fiji select the Despeckle option under the Process > Noise 610 
menu 611 
 612 
NOTE: This is a 3 x 3 median filter. 613 
 614 
5.4.2. Subtract background fluorescence following steps 5.4.3–5.4.6. 615 
 616 



   

 

5.4.3. Separate the channels of a multichannel image. In Fiji, select the option Split Channels 617 
under the Image > Color menu. 618 
 619 
5.4.4. Use the rectangle or circle selection tool to draw a small shape in an area of the image 620 
that does not have any fluorescent cells and measure the average pixel intensity of the 621 
background using Analyse > Measure. Repeat to sample multiple areas.  622 
 623 
NOTE: Make sure Mean Gray Value is selected in the Analyze > Set Measurements 624 
 625 
5.4.5. Average the mean gray value from 5–8 areas of background and drop the decimal point. 626 
Subtract this value from each pixel in the image using Process > Math > Subtract. 627 
 628 
NOTE: Rounding to the nearest whole number could over-estimate the background to subtract. 629 
It is more conservative to simply drop the decimal point. For example, 6.4 would be rounded 630 
down to 6, but 6.5 should also be rounded down to 6 to avoid the risk of subtracting 0.5 units of 631 
real signal from each pixel. 632 
 633 
5.4.6. If desired, merge the channels back into a multichannel image. In Fiji, use Image > Color 634 
> Merge Channels. 635 
 636 
5.4.7. Stitch the overlapping images together. 637 
 638 
5.4.8. Adjust brightness and contrast. In Fiji, use Image > Adjust > Brightness/Contrast. 639 
 640 
NOTE: Always use the same minimum and maximum values for each image to be compared. 641 
 642 
5.4.9. Count the number of green fluorescent cells following steps 5.4.10–5.4.12. These are the 643 
cells in which the candidate enhancer sequence was able to drive reporter expression. 644 
 645 
5.4.10. Start by hiding the green channel and use the freeform selection tool to draw a shape 646 
around the region of the brain that expresses red fluorescence. Using the Measure function in 647 
Fiji, measure the area, integrated density, and mean gray value of the red channel in this zone. 648 
 649 
5.4.11. Using the multi-point selection tool, count the number of green cells in this zone. 650 
 651 
5.4.12. Normalize the number of green cells by the integrated density of the red channel. The 652 
local red channel brightness is a proxy measure for the magnitude of virus exposure, enabling 653 
the comparison of enhancer activity between different transduced animals. 654 
 655 
REPRESENTATIVE RESULTS: 656 
Using these methods, a 915 bp sequence in the psychiatric risk-associated third intron of the 657 
gene CACNA1C19,49,50 was tested for enhancer activity in the postnatal mouse brain. This 658 
sequence was discovered in an MPRA of 345 candidate enhancer sequences centered on 659 
psychiatric and neurological risk SNPs12 and characterization experiments are described here as 660 



   

 

a general example. C57BL/6 mice were injected at P0 with an AAV9 construct packaged as a self-661 
complementary vector51 containing EGFP under the control of the Hsp68 minimal promoter and 662 
a single candidate enhancer sequence (Figure 3A). Additional mice were injected with constructs 663 
that contained a negative control sequence that was predicted to have no regulatory activity 664 
(Figure 3B). Viral titers for these constructs were normalized to 6.85 x 1010 vg/mL. All injected 665 
mice were co-injected with an AAV9-packaged construct containing mRuby3 under the control 666 
of the constitutive CAG promoter to visualize the area that was successfully transduced and 667 
control for potential variability in the site and spread of infection. Brains were collected at 668 
postnatal day (P)28 for immunohistochemistry and imaging. These experiments confirmed that 669 
this candidate enhancer region in CACNA1C drove expression of EGFP in P28 mouse brain (Figure 670 
3A), while a negative control sequence did not (Figure 3B). These results demonstrate the 671 
application of enhancer-reporter assays in the mouse brain, enabling in vivo study of enhancers 672 
during conditions that cannot be recapitulated using traditional in vitro models. 673 
 674 
These methods can also be used to test libraries of candidate enhancer sequences for activity 675 
using AAV-based delivery methods, such as in MPRAs. Representative images of library-based 676 
reporter expression at different titers demonstrate the flexibility of this assay and the effect of 677 
viral titer on transduction efficiency. High-titer (Figure 4A) versus low-titer (Figure 4B) viral 678 
preparations result in differences in the amount of transduced cells, as evidenced by both 679 
positive control mRuby3 expression driven by a CAG promoter and EGFP expression produced 680 
from the candidate enhancer libraries in postnatal mouse brain. There are situations where 681 
either high titer and broad transduction or low titer and sparse transduction may be preferred.  682 
 683 
FIGURE AND TABLE LEGENDS: 684 
Figure 1: Overview of the protocol. Key elements of this assay include a candidate enhancer 685 
element, a minimal promoter, a reporter gene, and, depending on assay design, a barcode 686 
sequence for unique tagging. These elements are cloned into an AAV plasmid backbone and 687 
packaged into AAV. The virus is delivered to the animal and left to incubate for a number of days 688 
or weeks. Finally, the tissue of interest is collected and enhancer activity is ascertained via 689 
imaging or sequencing. Enhancer-driven transgene expression can produce expression with cell-690 
type, regional, and temporal specificity, in contrast to constitutive drivers. 691 
 692 
Figure 2: Flexibility in assay design. (A) Plasmid orientation can place the enhancer upstream of 693 
the minimal promoter or downstream of the reporter gene, as in STARR-seq28. For sequence-694 
based readouts, a barcode is included downstream of the reporter gene, or the enhancer can 695 
serve as its own barcode in the second orientation. (B) Common viral delivery techniques to the 696 
brain include intracranial injections, retro-orbital injections, or tail-vein injections, which may 697 
result in different densities of transduced cells in different tissues. (C) Readouts can be 698 
sequencing-based or imaging-based. In sequencing-based readouts, enhancer activity is defined 699 
by a relative increase of RNA sequence versus input DNA sequence (controlling for AAV delivery). 700 
In imaging readouts, expression of the reporter gene is increased where the enhancer is active. 701 
(D) Potential intronic enhancers in the psychiatric risk-associated gene CACNA1C are highlighted. 702 
In the top image, a broad region is selected that shows strong associations to GWAS-tested traits 703 
and interactions with the CACNA1C promoter via PLAC-seq20. In the inset, smaller candidate 704 



   

 

regions are identified that are evolutionarily conserved at the sequence level, are in areas of open 705 
chromatin, and show epigenetic marks indicative of enhancers. 706 
 707 
Figure 3: Enhancer in CACNA1C drives EGFP expression in P28 mouse brain. (A) A mouse injected 708 
intracranially at P0 with an enhancer-reporter construct (scAAV9-Hsp68-EGFP-CACNA1C_3) and 709 
constitutively expressed injection control (AAV9-CAG-mRuby3) shows enhancer-driven EGFP 710 
expression in the middle-lower layers of the cortex at P28. (B) A mouse injected at P0 with a 711 
negative control construct (scAAV9-Hsp68-EGFP-NEG_4) and injection control does not show 712 
expression of EGFP at P28. Whole-brain images were taken at 5x magnification and insets show 713 
zoomed-in view of the boxed region. 714 
 715 
Figure 4: AAV-delivered enhancer-reporter libraries of different titers show activity in mouse 716 
brain. (A) Commercially packaged, high-titer AAV-PHP.eB library of candidate enhancers drives 717 
broad EGFP expression in P7 mouse brain. (B) Lower-titer AAV9 library of candidate enhancers 718 
precipitated from conditioned media of the packaging cells drives sparse EGFP expression in P7 719 
mouse brain. Images were taken at 5x magnification. 720 
 721 
Table 1: PCR reaction mix and thermocycling conditions. 722 
 723 
Table 2: Thermocycling conditions for colony PCR. 724 
 725 
Table 3:  Buffers for immunohistochemistry. 726 
 727 
DISCUSSION:  728 
This protocol describes an rAAV-based method for the deployment of enhancer-driven 729 
transgenes in the postnatal mouse brain. In this generalized protocol, a candidate enhancer, a 730 
minimal promoter, a reporter gene, and an optional barcode sequence are cloned into an AAV 731 
plasmid backbone. These experiments can be done with a single candidate enhancer sequence 732 
or with many sequences in parallel. The plasmid is packaged into an rAAV and delivered to the 733 
postnatal mouse brain. After a period of time to allow for virus transduction, the brain is collected 734 
and imaged for reporter gene expression. A constitutively expressed reporter virus (CAG-735 
mRuby3) is included as an injection control. Using this assay, enhancer elements are shown to 736 
drive transcription of EGFP in the mouse brain, demonstrating enhancer activity in vivo. 737 
 738 
The primary targets for troubleshooting and optimization of this assay include viral titer, injection 739 
technique, and transduction time frame. Different viral titers can have a strong effect on the 740 
density of transduced cells. While a higher transduction efficiency is likely preferable for most 741 
research, the optimal level of transduction is highly dependent on experimental goals. 742 
Intracranial injections offer a high density of transduced cells, but are likely to be more focal at 743 
the site of injection, though the spread of infection may depend on viral serotype and age of the 744 
animal52. Retro-orbital injections may show more even distribution of transduced cells 745 
throughout the brain but are less likely to give any area of high infection. Tail-vein injections can 746 
more effectively transduce other tissues in addition to the brain but will likely give still lower 747 
densities of transduced cells in the brain. Similarly, a variety of time-frames for virus transduction 748 



   

 

in the brain can serve different purposes. Robust scAAV expression can occur in the brain as early 749 
as seven days after intracranial injection, though periods of 28 days or longer are more typically 750 
used and yield strong expression. As enhancers can be temporally specific in their activity, it is 751 
important to consider the predicted activity of the tested enhancers when determining study 752 
design. 753 
 754 
There are some limitations associated with these methods that might make other options a more 755 
suitable choice, depending on experimental goals. Since AAVs exhibit low integration into the 756 
genome, tissues are most effectively transduced when they are mature and there is a high density 757 
of postmitotic cells, as a large amount of continued cell divisions will lower the density of 758 
transgene-expressing cells. For viral delivery of a transgene to a less mature model, such as 759 
tissues that are still growing, lentiviruses may be a more appropriate choice, as they integrate 760 
into the genome and will be inherited by all daughter cells of a transduced proliferating cell. 761 
Additionally, while the reporter assay described here is a widely used technique for the functional 762 
study of cis-regulatory activity, it cannot provide a complete picture of how the regulatory 763 
element acts within its native context. For example, this assay does not provide information on 764 
what genes may be targeted by the regulatory element in the genome. However, if the 765 
enhancer’s target genes are known, this information can be leveraged to determine if the cell 766 
types showing expression in this assay are the same as those known to express the enhancer’s 767 
targeted genes, which would lend high biological validity to the interpretation of results. The 768 
assay also may not completely recapitulate the effects that the surrounding genomic sequence 769 
or normal biological and behavioral activity of the animal may have on the activity of the tested 770 
regulatory element. Finally, this protocol describes the STARR-seq reporter assay design, in which 771 
the candidate enhancer element is cloned downstream of the reporter gene in the ORF, in 772 
contrast to upstream of the promoter, as in the conventional reporter assay cloning orientation. 773 
Including long variable sequences in the ORF of the reporter gene may cause reduced RNA 774 
stability due to factors such as RNA binding protein motifs, alternate splice sites, or variable GC 775 
content 36,53, and statistical methods have been developed to account for sequence-based biases 776 
when analyzing STARR-seq data54,55. Despite these considerations, STARR-seq MPRAs have been 777 
widely used in recent years to successfully identify cis-regulatory elements56–59. The methods 778 
described here can be easily adapted for use with the conventional MPRA orientation. 779 
 780 
The cell-type specificity of enhancers makes this assay a powerful tool in driving the cell-type-781 
specific expression of genes of interest in vivo. Current techniques for cell-type-specific 782 
expression of a desired gene can be limited by the availability of conditional expression 783 
constructs or require the generation of new transgenic mouse lines. Using an rAAV-based 784 
enhancer-driven system, a gene of interest can be expressed in a spatiotemporally specific 785 
manner by using validated cell-type-specific enhancers or promoters to drive expression13–15. 786 
Recent developments in this technology have shown that combining cell-type-specific enhancers 787 
with rAAV serotypes with tropisms for cells or tissues of interest can show similar specificity of 788 
transgene expression as in transgenic animal models60. This offers a cheap, fast, and potentially 789 
high-throughput method for sequence screening and specific induction of transgene expression 790 
in vivo in animal models. 791 
 792 



   

 

This technology also has therapeutic potential. Clinical studies have found that rAAV-based 793 
delivery of a transgene in vivo can induce the expression of healthy copies of a gene in cases 794 
where only a defective copy is present, or the gene is not being transcribed at a sufficient rate61–795 
63. The selection of a driving enhancer element has the potential to enable generalized delivery 796 
but expression induction in a cell-type-specific manner. Finally, delivering the transgene via rAAV 797 
also confers significant benefits; AAVs have lower immunogenicity than other viruses often used 798 
in transgene delivery64, making this a potentially safe viral vector to be employed for clinical use. 799 
 800 
Specific deployment of in vivo rAAV-based enhancer-reporter assays is customizable and can be 801 
modified to suit a range of experimental goals. Different tissues and cells can be targeted by 802 
selecting AAV serotypes or enhancers that have cell type or spatiotemporal specificity. Anywhere 803 
from one to thousands of enhancer-reporter constructs can be delivered in vivo, and activity can 804 
be assayed using a number of imaging- and sequencing-based readouts, as have been shown in 805 
an emerging set of studies using this approach15,16,65–68. The range of options for construct design 806 
and delivery enables this technique to be modified for a variety of uses in both translational and 807 
basic science, making this a powerful new tool for genomics and neuroscience research. 808 
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Table 1

5x reaction buffer 10 µL 

dNTPs final concentration of 200 µM each

Cloning primers final concentration of 0.2 µM each

Template DNA 50 ng

High fidelity polymerase final concentration of 0.02 U/µL

Nuclease-free water to reach 50 µL final reaction volume

30 cycles of the following:

Step Temperature Time

Denature  98 °C 10 s

Anneal 65 °C 20 s

Extend 72 °C 30 s

Final Entension 72 °C 2 min

Hold  4 °C

PCR Reaction Mix

Thermocycling conditions
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Table 2

Notes

Step Temperature Time

Denature 98 °C 10 s

Anneal 55 °C 15 s Optimal temperature may vary depending on primers.

Extend 72 °C 10 s Optimal duration may vary depending on polymerase.

Hold  4 °C

Thermocycling conditions

30 cycles of the following:
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Table 3

Buffer Composition

1x PBS 137 mM NaCl, 2.7 mM KCl, 10 

mM Na2HPO4, 1.8 mM KH2PO4

1x Citrate Antigen Retrieval 

Buffer (ARB ), pH 6.0

Proprietary, see table of 

materials

Permeabilization Buffer (PB) 1x PBS + 0.5% Triton X100

Wash Buffer (WB) 1x PBS + 0.1% Triton X100

Blocking Buffer (BB) WB + 5% milk 

Buffers for immunohistochemistry
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